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Matisse Menus

File Menu Open and Close Files, Acquire Images

Edit Menu Cut, Copy Paste, Marquee Commands

Object Menu Select, Align and Order Objects

Image Menu Image Processing Filters and Commands
View Menu Zoom, Show and Hide Windows

Window Menu Cascade, Tile , Arrange Icons
Help This Help Facility




The File Menu

The File Menu contains the standard commands of normal file management,
plus scanning and printing commands.

File: New Create new image, folder or palette

File: Open Open an existing image, folder or palette

File: Duplicate Duplicate an image, folder or palette

File: Close Close the current image, folder or palette

File: Restore Restore the current window to it's last saved state
File: Add To Folder Add the current window to a folder

File: Save Save the current image, folder or palette

File: SaveAs Save under a new name

File: Save All Save all Open Windows

File: Acquire Acquire an image from a Twain source (eg:scanner)
File: Select Source Select Which Twain Source

File: Open PhotoCD Open a Photo-CD file (Version 1.2)

File: Scan Scan using Microtek Scanner

File: Print Print an Image

File: Print Setup Set Paper Tray and Other options
File: Preferences Grid Size, Icon Size etc..




File: New

File: New: Image
File: New: Folder
File: New: Palette




File: New: Image

This command creates a new Color or Gray Scale Image. A dialog box
prompts for the size of the image (in pixels or inches) and the resolution
(dots per inch). If desired enter a resolution other than the screen resolution
in the resolution field. The resolution will effect the size of the image when
printed.



File: New: Folder

This command creates a new empty folder.



File: New: Palette

This command creates a new 256 color palette. This palette is displayed in
small format (no names). Use the Palette Names command on the Edit
Menu to change this so that you can input names.



File: Open

File: Open: Image
File: Open: Palette
File: Open: Folder




File: Open: Image

Opens an existing image using the standard Microsoft file dialog box.



File: Open: Palette

Opens an existing palette. Palettes have a .pal extension.



File: Open: Folder

Opens an existing folder. Folders have a .fld extension.



File: Duplicate

Creates a duplicate of the active window. Depending on the window type, it
will create a new Image, Folder or Palette.



File: Close (F3)

Closes the current window. If changes have been made to the window, the
program will ask whether you want to save those changes.



File: Restore

Restores the current window to its last saved state.



File: Add to Folder

Manually adds the active window to an open folder. If there is only one folder
open, the program will add the window object to that folder. Otherwise the
program prompts you to select a folder from a list of open folders.

Note: An easier way to add images to folders is to iconify the image and then
drag the image into the folder. If you hold down the <shift> key, the image
will be copied into the folder. Otherwise it will be cut into the folder.



File: Save (F2)

Saves the active image, palette or folder.



File: SaveAs

Saves the active image, palette or folder under a new name.



File: Save All (F4)

Saves all open images, palettes and folders.



File: Acquire

This command allows you to acquire an image via a TWAIN source, for
example a TWAIN scanner or digital camera. To set which source is active
use the File: Select Source command.

Note: TWAIN is a standard interface which is common accross a range of
input devices. We highly recommend that when purchassing an input
device such as a scanner or digital camera, you make sure that it is "TWAIN"
compliant. This will ensure that it is compatible with Fauve Matisse and
other programs



File: Open PhotoCD (Version 1.2)

This command allows you to retrieve images in Photo-CD format from your
CD ROM drive. When applied it will automatically access your CD Rom drive
and display a folder of thumbnails corresponding to the images on disk.
Photo-CD stores each image in a number of different resolutions. A menu at
the top of the PhotoCD folder allows you to specify which resolution you want
to import the image in as. To activate the import, simply double click on the
photo-CD thumbnail.

Note that the folder will be kept around as a separate window, allowing
access to the images on disk at any time. The Window may be minimized to
conserve screen space or closed.



File: Select Source

This command allows you to switch between TWAIN sources. For instance
you could have several scanners connected to the computer, and you could
be selecting Scanner2 as your TWAIN input source.



File: Scan

This leads to a scan menu which controls the scanner. The menu and the
controls are different depending on which scanner you have installed, ie: a
standard TWAIN scanner or a non-TWAIN Microtek scanner. By default, the
program installation assumes your scanner is TWAIN (most likely). To install
an older Non-Twain Microtek scanner use the "Custom Install" option of the
Matisse Install program



File: Print (Ctrl+P)

Prints the active image on your Windows compatible printer



File: Print Setup

Sets the print quality and number of copies



File: Preferences

File:

Preferences:

Gamma Correction

File:

Preferences:

Grid Size

File:

Preferences:

Icon Size

File:

Preferences:

GrayScale Only

File:

Preferences:

Windows Clipboard

File:

Preferences:

Printer Quality Text

File:

Preferences:

JPEG Compression Ratio

File:

Preferences:

LZW Compression




File: Preferences: Gamma Correction

When you click on this preference choice, a dialog box will appear allowing
you to enter screen gamma values for the red, green and blue channels.
These values affect the overall appearance of colors on your screen. To
ensure that Matisse is displaying true colors, you must "calibrate" your
monitor by setting these values.

1. Open the file "gamma.mat"

2. Adjust the red gamma control until the outer and interior shades of red in
the image match precisely. You can do this by using the "Preview" button
after each trial value.

3. Do the same for the green and blue channels.

4. Hit OK to confirm.



File: Preferences: Grid Size

Like a draw program, Matisse supports "Snap to Grid" of objects. "Grid Size"
refers to the size (in pixels) of this invisible grid.



File: Preferences: Icon Size

Sets the default icon size that is used for displaying minimized images,
folders and palettes.



File: Preferences: Gray Scale

Sets the display of all windows, images, icons etc. to gray scale. Useful for
viewing gray scale images on non-24 bit displays (higher quality images).
Color images will be rendered in gray, but the colors will not be lost.



File: Preferences: Windows Clipboard

If checked, all cut and copy operations will result in a duplicate copy being
sent to the Microsoft clipboard.



File: Preferences: Printer Quality Text

When checked, this preference setting will cause Matisse to print text at the
resolution of the printer as opposed to the resolution of the image. This
feature allows you to annotate a screen resolution image with letter quality

text.



File: Preferences: JPEG Compression Ratio

This setting specifies a compression ratio from 1 to 100 for saving JPEG
images. Beware of ratios greater than 4 that can lead to visible loss of image

quality.



File: Preferences: LZW Compression

When checked, this preference item will cause Matisse to save TIFF files
using the so-called "LZW" compression scheme.



The Edit Menu

The Edit Menu contains commands for selecting marquee areas as well as
the standard "Cut" "Copy" and "Paste commands".

Edit: Undo Undo the last command

Edit: Cut Cut to the clipboard

Edit: Copy Copy to the clipboard

Edit: Paste Paste as Object or New Document
Edit: Marguee All Set Marquee to Entire Window
Edit: Marquee Invert Invert Marquee

Edit: Marqguee None Eliminate Marquee
Edit: Clear Clear to white

Edit: Fill Fill to a color or pattern

Edit: Set Pattern Define a new Current Pattern
Edit: Set Texture Define a new Current Texture
Edit: Brushes Edit Brush Set

Edit: Palette Edit Current Palette

Edit: Folder Edit Folder Options



Edit: Undo (Alt+Bksp)

Undoes the last operation.



Edit: Cut (Shift+Del)

Cuts the current selected object to the private clipboard. Normally it will
also cut a copy to the Microsoft Windows clipboard for easy communication
with other applications. This feature can be turned off in the Preferences

Menu.



Edit: Copy (Ctri+Ins)

Copies the current selected object to the clipboard. Normally it will also
copy a copy to the Microsoft Windows clipboard for easy communication with
other applications. This feature can be turned off in the Preferences Menu.



Edit: Paste (Shift+Ins)

Pastes the content of the clipboard into the current window. If the Windows
clipboard is non-empty it will use that clipboard, otherwise it will use the
private clipboard.

Note (Version 1.2). Fauve Matisse can now "Paste as New Document". This
feature is convienent for interfacing with external applications.



Edit: MarqueeAll (Ctri+A)

Creates a marquee including all of the current window.



Edit: Marquee Invert

Inverts the current Marquee.



Edit: Marquee None (Ctrl+D)

Discards the current marquee



Edit: Clear (Ctri+Del)

Sets all selected image objects to white. If no image objects are selected,
sets the background image to white.

Note: if the image is a transparency, clear will effect the opacity layer as
well, making the image 100% transparent.



Edit: Fill

Fills all currently selected objects. If no objects are selected, the fill will apply
to the background image. In either case, the fill will be clipped to the
marquee, if one is present.



Edit: Set Pattern

Defines the current pattern. If the active window is an image window, it will
use that image (clipped to the marquee) as the new pattern. If the active
window is a folder, it will use the first selected image in the folder as the new
pattern.



Edit: Set Texture

Re-defines the current texture. If the active window is an image window, it
will use that image (clipped to the marquee) as the new texture. If the
active window is a folder, it will use the first selected image in the folder as
the new texture.



Edit: Brushes

Menu commands for editing the brush set.

Edit:

Brushes:

Open

Edit:

Brushes:

SaveAs

Edit:

Brushes:

Add Category

Edit:

Brushes:

Add Brush

Edit:

Brushes:

Delete Category

Edit:

Brushes:

Delete Brush

Edit:

Brushes:

Set Category Icon

Edit:

Brushes:

Get Category Icon

Edit:

Brushes:

Set Brush Icon

Edit:

Brushes:

Get Brush Icon




Edit: Brushes: Open

Opens an existing brush set (extension .brs).



Edit: Brushes: Save As

Saves the brush set under a new name.



Edit: Brushes: Add Category

Inserts a new default category into the brush box



Edit: Brushes: Add Brush

Inserts a new default brush into the brush box



Edit: Brushes: Delete Category

Deletes the current category from the brush box.



Edit: Brushes: Delete Brush

Deletes the current brush from the brush box



Edit: Brushes: Set Category Icon

Uses the current image window to (re)-set the current category icon. If the
current image window is not 64x64 pixels, the icon is obtained by
resampling.



Edit Brushes: Set Brush Icon

Uses the current image window to (re)-set the current brush icon. |If the
current image window is not 64x64 pixels, the icon is obtained by
resampling.



Edit: Brushes: Get Category Icon

Copies the current category icon into a new image window.



Edit: Brushes: Get Brush Icon

Copies the current brush icon into a new image window



Edit: Palette

Menu commands for editing the current palette.

Edit:

Palette:

Find

Edit:

Palette:

Find By Name

Edit:

Palette:

Interpolate

Edit:

Palette:

Rectangle Interpolate

Edit:

Palette:

Resize

Edit:

Palette:

Samplelmage

Edit:

Palette:

Names




Edit: Palette: Find

Finds the closest matching color to the foreground color in the palette.



Edit: Palette: Find By Name

Brings up a dialog box where you can search for a palette color by name.



Edit: Palette: Interpolate

Interpolates between the top left selected color and the bottom right
selected color to provide a range of intermediate palette colors.



Edit: Palette: Rectangle Interpolate

Interpolates between the four corners of the selected area in the palette to
give a

“Gouroud" shading of intermediate colors. Useful for deriving blends of
several colors.



Edit: Palette: Resize

Allows you to change the number of palette rows and columns (by default
palettes are 16x16 and contain 256 colors).



Edit: Palette: Sample Image

Creates a new palette by computing out the top colors in the image using the
Heckbert quantization technique.

Once you have the top colors of an image, you can use these colors to
colorize another image with the Colorize command. This can produce
remarkable results!



Edit: Palette: Names

Allows you to view the palette in large format, so that the names are visible.
This command acts as a toggle.



Edit: Folder

Edit: Folder: Resize
Edit: Folder: Get Cover
Edit: Folder: Set Cover




Edit: Folder: Resize

Resizes the icons in the current folder.



Edit: Folder: Get Cover

Copies the folder cover into a new image window. The folder cover is the
image that is shown when the folder is iconified, or dragged into other

folders.



Edit: Folder: Set Cover

Sets the cover of a folder using the current image window. The folder cover
is the image that is shown when the folder is iconified, or dragged into other

folders.



The Image Menu

The Image menu contains all of the filters in Matisse as well as some image
processing commands.

Image: Tune
Image: Blur

Image: Convolution
Image: Distort
Image: Edge Detect
Image: Mosaic
Image: Noise
Image: Texturize
Image: Separate
Image: Recombine
Image: Convert
Image: Crop
Image: Flip

Image: Rotate 90
Image: Resample
Image: AutoPaint




Image: Tune

Image: Tune:

Brightness/Contrast

Image: Tune:

CMYK

Image: Tune:

Colorize

Image: Tune:

Equalize

Image: Tune:

Invert

Image: Tune:

HLS

Image: Tune:

Posterize

Image: Tune:

RGB

Image: Tune:

Tint

Image: Tune:

Tone




Image: Tune: Brightness/Contrast

Similar to the Brightness/Contrast controls on a TV. Increasing brightness
adds pure white to the image. Increasing contrast tightens the color range.



Image: Tune: CMYK

Adds/Subtracts a fixed amount of Cyan, Magenta, Yellow or Black to each
pixel in the image.



Image: Tune: Colorize

Colorizes an image using a 256-color palette. If you don't have such a
palette, you can use the Edit: Palette: Sample Image command to extract
one from another image.

Note: This command only works on color images. If you want to colorize a
gray scale (8 bit image) first convert it to True Color, and then apply the
command.

See Also: Edit: Palette: Sample Image




Image: Tune: Equalize

This command equalizes out the image to contain an even mix of light and
dark areas. It is particularly useful for re-touching under or over-exposed
photographs, particularly gray-scale ones.



Image: Tune: Invert

Inverts the image, producing a negative.



Image: Tune: HLS

Adds/subtracts hue, lightness, and or saturation. Pumping up the saturation
on an image is often a good way of adding life to it.



Image: Tune: Posterize

The term "posterize" means to compress the range of color values. For
example, on a gray scale image, setting the posterize level to five will result
in each channel going from 256 shades to 5 shades. This results in images
which are somewhat "blotchy".



Image: Tune: RGB

Adds/Subtracts a fixed amount of Red, Green or Blue to each pixel in the
image.



Image: Tune: Tint

Creates a 256-shade image which "leans" towards the foreground color.
Gives a very clean, "tinted" look to an image or area which you cannot get by
other tuning adjustments.



Image: Tune: Tone

Overall tone adjustment facility. Allows you to increase the shadows,
midtones or highlights of the image and see the effects on the image
interactively. The controls in effect re-ramp each of the gamma curves for
the three channels R, G and B.



Image: Blur

Filters for blurring an image.

Image:

Blur

: Blur

Image:

Blur

: Fragment

Image:

Blur

: Motion Blur

Image:

Blur

: Gaussian Blur

Image:

Blur

: Uniform Blur




Image: Blur: Blur

Applies a 3x3 convolution blur to the image. A blur amount parameter is
used to increase/decrease the weight on the center pixel, mildly changing

the degree of blur.

Use for: applying a mild blur to the image.



Image: Blur: Fragment

Superimposes a specified number of copies at random offsets. The variance
of these offsets can be specified in pixels.

Use for: creating the effect of a "jiggled" camera.



Image: Blur: Motion Blur

Superimposes a specific number of copies at a given distance from each
other and at a specified angle to create the impression of movement. Using 4
or more copies at a distance of 3 pixels yields good results.

Use for: creating the impression of movement.



Image: Blur: Gaussian Blur

Applies a smooth normalized or "gaussian" blur filter to the image. More
“soft" than other blur filters, but slower. Blur amount is specified by a radius
in pixels (1-5).

Use for: creating "soft lens" effects.



Image: Blur: Uniform Blur

Applies a uniform blur filter to the image. Essentially the same as the
standard blur filter, but with a variable radius of up to 5 pixels (10x10
convolution). Like the gaussian blur, can be slow, especially on large images.

Use for: creating "soft lens" effects.



Image: Convolution

The term "convolution" is an image-processing term for a class of filters
which are defined by a matrix of numbers. For each pixel, the new RGB
values are defined as a weighted sum of the adjacent pixels. The convolution
matrix allows you to enter these weights. The result is divided by a scale
factor, and shifted by an offset.

Use for: creating your own filters.



Image: Distort

Filters for distorting an image.

Image:

Distort: Cylinder

Image:

Distort: Fish Eve

Image:

Distort: Ripple

Image:

Distort: Wave

Image:

Distort: Whirlpool




Image: Distort: Cylinder

This filter maps the image to a cylinder, like a "special effects" mirror at an
amusement park. You can specify an amount between -100 and +100. A
positive amount will cause the image to "bulge" , a negative amount will
cause it to be "squeezed". You can also specify whether the cylinder is
vertical or horizontal.

Use for: creating cylinder-like bulges and squeezes.



Image: Distort: Fish Eye

Creates the impression the picture was taken through a fish-eye lens. The
degree of "bulge" is controllable with an amount parameter. Specifying a
negative amount will cause the image to be "pinched"

Use for: creating fish-eye or pinched effects.



Image: Distort: Ripple

Creates a "rippled" wave over the image, similar to looking through heavy
plate glass on a rainy day. The ripple is controlled by a wavelength and an
amplitude factor. The best way to see how these two parameters interact is
by playing around with them!

Use for: creating a non-directional ripple over an image.



Image: Distort: Wave

Creates a horizontal or vertical wave on the image. The wavelength and
the amplitude of the wave can be specified. Like the Ripple filter, this one
takes some trial and error to get comfortable with.

Use for: creating waves in an image.



Image: Distort: Whirlpool

Passes the image through a whirlpool vortex, creating a "twirl" effect. A twist
amount in degrees (between -360 and +360) controls the degree of twirl.

Use for: "twirling" all or part of the image.



Image: Edge Detect
Filters that detect and act on the edges of the image.

Image: Edge Detect: Emboss
Image: Edge Detect: Find Edge
Image: Edge Detect: Sharpen
Image: Edge Detect: Threshold
Image: Edge Detect: Variable Edge




Image: Edge Detect: Emboss

Creates an "embossed look" using directional gradient information. The
emboss depth controls how “protruded” the embossing looks. The contrast
parameter is useful for increasing the sharpness of the embossing. The
emboss angle is entered in degrees. Finally, you can specify a background
color for embossing: foreground, background or gray.

Note: you can also emboss an object interactively with any paintbrush by
setting the object compositing rule of that object to emboss.



Image: Edge Detect: Find Edge

Standard filter which finds all edges of the image and displays them in white
on a black background. By checking the invert box, you can specify black
edges on a white background.

Use for: special effects.



Image: Edge Detect: Sharpen

Accentuates the edges of an image to increase the perceived "sharpness". A
single parameter, amount, is used to regulate the degree of edge
enhancement.

Use for: sharpening blurred images.



Image: Edge Detect: Threshold

This filter classifies all pixels into two categories: those whose R,G,B values
are above a certain threshold and those who are below. The R,G,B
threshold values are entered with three sliders and can be constrained to
be equal by clicking on the constrain checkbox. You specify one color for the
"above" pixels and one for the "below" pixels.

Use for: creating "Andy Wharhol" like thresholded images.



Image: Edge Detect: Variable Edge

A highly versatile filter for the image professional. For each pixel an edge
gradient is computed. Depending on whether the edge is greater or less than
a specific threshold, the pixel is colored in the "above" color or the "below"
color. Color choices include

HiLite (which sharpens the pixel) , Unchanged (leaves the pixel as is) and

Raw (the raw gradient number, as displayed by the standard Find Edge
filter).

Use for: sophisticated edge detection and special effects.



Image: Mosaic

Included under this heading are filters which produce a clustered "mosaic"
effect.

Image: Mosaic: Maximum
Image: Mosaic: Median
Image: Mosaic: Minimum
Image: Mosaic: Mosaic
Image: Mosaic: Shatter




Image: Mosaic: Maximum

This filter replaces each pixel with the lightest (maximum) pixel in a
neighborhood around it. The neighborhood radius is given in pixels. Using
values greater than 1 can slow this filter considerably.

Use for: clustering the image pixels into areas of maximum lightness.



Image: Mosaic: Median

This filter replaces each pixel with the median lightness pixel in a
neighborhood around it. The neighborhood radius is given in pixels. Using
values greater than 1 can slow this filter considerably.

The effect of the median filter is to blur the image without destroying edges.
It is perfect for removing noise from an image, or blurring flat parts of an
image while keeping straight lines relatively crisp. While not really a
“mosaic” filter, we included it here to be next to the minimum and maximum
filters.

Use for: controlled blurring and noise removal.



Image: Mosaic: Minimum

This filter replaces each pixel with the darkest (minimum) pixel in a
neighborhood around it. The neighborhood radius is given in pixels. Using
values greater than 1 can slow this filter considerably.

Use for: clustering the image pixels into areas of minimum lightness.



Image: Mosaic: Mosaic

Creates the "police suspect" look by grouping pixels in tiles and coloring each
tile with its average color. You can specify the width and height of the tiles,
and constrain these to be equal by click the square checkbox.

Use for: "pixelating" an image into rectangular tiles.



Image: Mosaic: Shatter

Creates a "David Hockney" look by cutting the image up into tiles and
moving the tiles randomly around. You specify the tile width and height, the
average movement in pixels, and optionally an amount of random tinting
that is applied to each tile.

Use for: David Hockney effects.



Image: Noise
These filters add/subtract random noise to the picture.
Image: Noise: Add Noise

Image: Noise: Diffuse
Image: Noise: Remove Noise




Image: Noise: Add Noise

Adds a specific amount of white noise to the image. The amount is specified
between 1 and 255.

Use for: adding a grainy noise background to your image.



Image: Noise: Diffuse

Moves each pixel by a random amount, creating a very nice "grainy
breakdown" of the image.

Use for: creating soft, artistic grainy breakdowns.



Image: Noise: Remove Noise
Checks each pixel's color relative to the median color of the neighboring

pixels. If the difference is greater than a threshold, the pixel color is replaced
with the median color. The strength parameter controls the noise threshold.

Use for: cleaning up spotty images.



Image: Texturize

Texturizes the image using the current texture. The texture amount can be
set to a number between 1 and 200. The angle of the light source can be
entered in degrees.

Use for: adding paper texture to images.



Image: Separate
These commands break an image down by channel.
Image: Separate: RGB

Image: Separate: HLS
Image: Separate: CMYK

After separating out an image into the different channels, each channel is
given its own window, and can be modified using any of the paint or image
processing commands. The Image: Recombine command can then be used
to re-create a composite of the different channels.

See also: Image: Recombine




Image: Separate: RGB

Separates an image out into its Red, Green and Blue channels.



Image: Separate: HLS

Separates an image out into Hue, Lightness and Saturation channels.



Image: Separate: CMYK

Separates an image out into the print standard Cyan, Magenta, Yellow and
Black channels. To optimize the separation, you can modify any of the
following parameters:

Threshold: Starting threshold in % below which there is no black being
generated.

Black generation: max % of black that will be generated.

Under color removal: % of black that will be removed from each C,M,Y
triplet.



Image: Recombine

Recombines a set of gray scale channels to form a color image. You must
select whether to recombine split RGB, HLS or CMYK images.

See also: Image: Separate




Image: Convert
Converts an image from one image type to another.
Image: Convert: To Gray Scale

Image: Convert: To Indexed 256
Image: Convert: To True Color




Image: Convert: To Gray Scale

Converts the image to 8-bit gray scale. No arguments are needed.



Image: Convert: To Indexed 256

Converts the image to the indexed 256 format. When converting from gray
scale no arguments are needed: the indexed image's palette is set to the
256 shades of gray.

When converting from color, you are asked to choose between medium
quality (pattern dither using a system palette) or high quality (using a
diffusion dither and adaptive palette). Note: If you do not have a 24 bit
graphics card Matisse will use a dithered display and you will not be able to
visually see any difference between the two images while in the program.
However, if you use a different application which resets the system palette,
or if you try it on a 24 bit display, the image will show up at superior quality.



Image: Convert: To True Color

Converts the image to True 24 bit color.



Image: Crop

Crops the image to the current marquee.



Image: Flip

Flips the entire window (including all objects) either horizontally or vertically.



Image: Rotate 90

Rotates the entire window (including all objects) by 90 degrees.



Image: Resample

Resamples the entire window (including all objects) to a given new width and
height. These can be entered in either in pixels, inches, or as percent of the
original image. You can also constrain the aspect ratio to be fixed to the
aspect ratio of the old image.



Image: AutoPaint

This switch toggles on auto painting mode. With AutoPaint, when the brush
tool is active the right mouse button causes Matisse to automatically fill the
image using the last brush stroke. (Normally the right mouse button simply
repeats the last stroke once).



The Object Menu

The Object Menu contains commands that used for selecting, grouping and
aligning objects on the screen.

Object: Make Floating
Object: Merge
Object: Merge Control
Object: Select All
Object: Select None
Object: Delete
Object: Flip

Object: Soften
Object: Set Outline
Object: Set Interior
Object: Group

Object: UnGroup
Object: Order

Object: Snap To Grid
Object: Align

Object: Align To Image
Object Location
Object Opacity




Object: Make Floating(Ctri+0)

Creates a "floating" image object by copying the bits under the current
Marquee.



Object: Merge (Ctri+M)

Merges all selected objects onto the composite. When an object is merged all

of its pixels are copied to the background image, and the object information
is lost.



Object: Select All (Ctri+X)

Selects all objects in the active Window. Do not confuse it with the Select All
command in the Edit Menu which is used for selecting a Marquee.



Object: Select None(Ctri+2Z)

Deselects all objects in the active Window. Do not confuse it with the Select
None command in the Edit Menu which is used for selecting a Marquee.



Object: Delete (Del)

Deletes all the currently selected Objects in the active Window.



Object: Flip

Flips selected objects, either horizontally or vertically. If you wish to flip the
entire image, use the Image: Flip command.

See also: Image: Flip



Object: Merge Control

Sets the merge control options that apply to the top-most selected object.
These options depend on the type of object: image, shape or text.

For image objects there exists a checkbox allowing you to specify that the
image is a Transparency, i.e.: that its background is non-opaque.
Transparencies are handy for "writing" on top of another image and for other
effects.

For shape objects, a different checkbox allows you to turn off the drawing of
borders. This is useful for creating crisp filled shapes with no outline.

For Text objects, a text entry box and font selector are provided.

For all objects, you can select the compositing rule that determines how the
object is merged onto other objects beneath it.



Object: Soften

Softens the edges of an object. Matisse does this by applying a blur filter to
the selection mask defining the object. The soft-edge amount is given in
pixels.



Object: Group (Ctrl+G)

Unifies selected objects so that they move as one. You can have groups of
groups and so on... To undo the group use the Object: UnGroup command

See Also: Object: UnGroup.




Object: UnGroup (Ctri+U)
This command is used to diss-associate grouped objects.

See Also: Object: Group.




Object: Order
These commands change the older of objects on the desktop

Object: Order: Send To Front
Object: Order: Send To Back
Object: Order: Move Up
Object: Order: Move Down




Object: Order: Send To Front (Ctrl+F)

Sends the current selected objects to the top of the desktop.



Object: Order: Send To Back (Ctrl+K)

Sends the current selected objects to the back of the desktop.



Object: Order: MoveUp

Moves the selected objects up one layer on the desktop.



Object: Order: Move Down

Moves the selected objects down one layer in the desktop



Object: Location (Version 1.2)

This command brings up a popup menu allowing you to "remember" the
position of an object and to "restore" the object to that position.
Alternatively, you can use the Home key to restore an object to it's
remembered position..



Object: Snap To Grid

Toggles Snap to Grid Mode. When Snap to Grid is checked all objects,
marquees etc.. snap to fixed grid points when moved.



Object: Align

Aligns a set of objects relative to each other. For instance, selecting Align
Left will cause all selected to be left-aligned to the left-most object.

Since the align command tends to be used frequently, we have assigned the
following easy-to-remember keyboard accelerators:

CTRL+L Object: Align: Left
CTRL+R Object: Align Right
CTRL+T Object: Align Top
CTRL+B Object: Align Bottom
CTRL+C Object: Align Center

The Shift versions of these accelerators are used for the Align To Image
commands.

See Also: Object: Align to Image.




Object: Align: Left

Aligns selected objects to the left side of the bounding rectangle.



Object: Align: Right

Aligns selected objects to the right side of the bounding rectangle



Object: Align: Top

Aligns selected objects to the top side of the bounding rectangle.



Object: Align: Bottom

Aligns selected objects to the bottom side of the bounding rectangle.



Object: Align: Center

Aligns selected objects to the center of the bounding rectangle.



Object: Align To Image: Left

Aligns selected objects to the left side of the image.



Object: Align To Image: Right

Aligns selected objects to the right side of the image.



Object: Align To Image: Top

Aligns selected objects to the top side of the image.



Object: Align To Image: Bottom

Aligns selected objects to the bottom side of the image.



Object: Align To Image : Center

Aligns selected objects to the center of the image.



Object: Align To Image

These commands are used to align a set of objects to the edges of the image
window.

Since these command tends to be used frequently, we have assigned the
following easy-to-remember keyboard accelerators:

CTRL+SHIFT+L Object: Align To Image: Left
CTRL+SHIFT+R Object: Align To Image: Ri